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1 Introduction

The Cloud Security Connector (CSC) Multiplex GRE allows to connect securely Zscaler Cloud
Security Services to more than 1 Gbps.

The main purpose of the CSC Multiplex GRE family is simplicity: You don’t need to re-architect
your network and is a direct replacement of your current Web Security Appliance. You can place the
CSC Multiplex GRE on the same network segment that you current appliance and the CSC will
redirect the traffic to Zscaler.

No configuration is required. Simply fill a form with your IP address and download the CSC and
power it on.

The CSC Multiplex GRE comes with the perfect parameters to work with Zscaler. As soon you
lunch the CSC at the location, the CSC will automatically connect to the best Zscaler nodes. The
CSC Mutliplex GRE contain the perfect configuration for GRE tunnels, firewall rules and routing
tables that are necessary.

No restrictions: You can run it on any virtual software and hardware version is also available.
All Zscaler functionalities are available. Internal IPs are completely visible on the Zscaler GUI.

Simple to install with full management from Amazon AWS. The CSC is a cloud instance running on
your premises.

2 CSC Multiplex GRE - Network diagrams

CSC Multiplex - GRE

Internal Side: External Side: Multiple GRE Tunnels

Simple Architecture Bandwith aggregation
A. (2 or 3) x GRE Tunnels

ZEN
Primary Destination

Primary Tunnels
(2 or 3) x GRE

—» (Hew T »
_> (2) VIP Proxy - 2’

_) (3) Bypass Proxy
>

(2 or 3) x GRE =

Direct to Intemet

= ZEN
SecondanyTunnels E@é Secondary Destination

(2 or 3) x Egress Bypass

External Side:
Multiple Egress Bypass
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3 Key bhenefits of the Cloud Security Connector
Multiplex GRE

* No Networking knowledge required. No configuration.

* Direct replacement of your current appliance Web Security Appliance.

* Enables any Location to be connected to Zscaler Cloud Security Services to more 1 Gbps.
e Full tunnel redundancy.

* Full use of all bandwidth available at all Internet Links.

* VIP proxy to direct the traffic to Zscaler.

* Bypass Proxy to send the traffic direct to Internet.

* Easy configuration: After you buy the CSC, you will need to fill a form indicating your IPs
and GWs. After the form is submitted, you will receive the OVA file to install.

e All parametrization required for Zscaler is already configured with the optimal values.
* All Zscaler functionalities can be used: Firewall and Web Security.

* Full visibility of internal IPs.

* No operational burden for Administrators.

* Full hardened device.

*  Works behind a NAT

* All virtual platform supported: Vmware, Hyper-vV, KVM, Virtual Box, etc.

* Hardware version available if required.

* One click Status and Configuration. This shows all values and does all checks for you in one
step.

* Amazon AWS management

*  MTR (MyTraceRoute) test to the Zscaler nodes and in the reverse path as well.
* Speedtest.net integrated

*  Works with No default Route Scenarios.

¢ Small OVA instances.
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4 Creating the CSC Multiplex GRE

To create the CSC Multiplex GRE is very easy. You just need to fill a form with your IP addressing
and the GRE tunnels IPs.

Here the network diagram showing the information required:

3) DNS Servers

(2 or 3) x GRE Tunnel
p— Switch Firewall Public IPs
L2/L3 ‘L /

CSC Multiplex - GRE

= o
= Primary Destination

=

2

6) Syslog Servers

e 5) EXT-GW

1

7iS

%E ZEN
g Secondary Destination

Direct to Intemet

External

&
4) EXT-First-IP/BitMask
(Note: FOUR or SIX consecutive IPs will be used)

CSC Multiplex - GRE

4.1 Submit a ticket to Zscaler Support for GRE Instructions

You will need to submit a ticket to Zscaler to request the GRE tunnels. When submitting a ticket to

Zscaler you need to specify the GRE tunnels Public IPs (in blue in the diagram above)

=>» From the GUI, Go to: Help > Submit a Ticket

Zscale x | 4

lerth.. o * @ @@ &

o :

© 2018 — Maidenhead Bridge Limited Page 6 of 57 Date 11/10/18



CSC Multiplex GRE — Admin Guide

=>» You will be redirected to the Submit Ticket Page:

Submit Ticket

Contact Email”

Issue Subject”

CC List (separate multiple email

addresses with a comma)

Description”®

Customer Type*
Request Overview”
Ticket Type*

Product And Feature”
Priority”

Area”

Provisoning

Contact Name”
Organization”
Contact Phone
Requester Time Zone*

Upload a file (often helps
troubleshoot issues)

‘{Y::-ur Email> |

‘Please,create the following GRE tunnels| |

Hi Friends,

Please, Create this GRE tunnels from this
Public IPs: Public IP 1 <IP address>, Public IP
2 <IP address>. This IPs are Located at: <City>
<State> <Country= y

[Current Customer v
[Administrative - Provisioning Request v
[as ]
214 - General ]

Mormal v
[Provisioning v
[GRE Tuninel ]

‘-:Your Name=> |

‘c‘r’our Organisation Name> |

UTC +0 GMT v

Choose file |No file chosen

Where Public IP 1, Public IP 2 (optional Public IP 3) are the Public IPs of GRE tunnels.

Important: You need to specify the <city>, <state> and <country> where the IP is located. This
allows Zscaler Support to indicate the best ZEN nodes for your location.
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=>» After the ticket is submitted, you will receive an email with the GRE information, like this
one:

[Tunnel source IP:  82.68.6.73 |
Internal Range: 172.17.4.208-172.17.4.215

Primary Destimation: 165.225.16.36
Internal Router IP: 172.17.4.209/30
Internal ZEN IP: 172.17.4.2168/30
Secondary Destination: 165.225.76.39
Internal Router IP: 172.17.4.213/38
Internal ZEN IP: 172.17.4.214/30
[Tunnel Source IP: 82.68.6.74 |

Internal Range: 172.17.4.216-172.17.4.223

Primary Destination: 165.225.16.36
Internal Router IP: 172.17.4.217/308
Internal ZEN IP: 172.17.4.218/30
Secondary Destimation: 165.225.76.39
Internal Router IP: 172.17.4.221/38
Internal ZEN IP: 172.17.4.222/308

Please, note that Tunnel Source IP = <GRE Public IP> and the values remark in green will be
requested when filling the “CSC GRE Form”
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4.2 Create the Location on Zscaler GUI

On the Zscaler GUI, go to Administration > Location > Add Location

=>» Mandatory: Put Name, Country and Time Zone. Select all Public IPs requested for the

location.
Edit Location
LOCATION
Name Country
csc-lb-73-74-75 United Kingdom v
State/Province Time Zone
Berkshire Europe/Londaon v
Group
MNone w
ADDRESSING

Static IP Addresses

82.68.6.73; 82.68.6.74; 82.68.6.75 w

VPN Credentials

MNone w

GRE Tunnel Information 3 Export

Tunnel Sourc...

Primary Desti...

Primary Destination Internal Ra... Secondary Destination Internal ...

1 B82.68.6.73 165.225.16.36 165.225.76.39 172.17.4.208 - 172.17.4.211 172174212 -172.17.4.215
2 B82.68.6.74 165.225.16.36 165.225.76.39 172.17.4216 - 172.17.4.219 172.17.4.220 - 172.17.4.223
3 82.68.6.75 165.225.16.36 165.225.76.39 17217.48-1721741 17217412 -172.17.4.15

=>» Optional: Select additional options for the Location according your design, like Enforce
Authentication, SSL inspection, Surrogate IP, etc.

GATEWAY OPTIONS

Enable XFF Forwarding
Enable IP Surrogate
Enforce Surrogate IP for Known Browsers

@ ]

Enforce Authentication

Idle Time to Disassociation

B Hours R

Enable SSL Scanning

Enforce Firewall Control
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= Recommended (1): Enable “Enforce Firewall Control”. This will enforce all traffic to leave
the Zscaler Cloud from the same outgoing IP for all tunnels. IMPORTANT: You must create
a Firewall Rule for the Location allowing the traffic to go out, like:

Firewall Control

Configure Firewall Control Policy
Rules are evaluated in the order specified. Rule evaluation stops at the first match.

FIREWALL FILTERING POLICY MNAT CONTROL POLICY

© Add Firewall Filtering Rule © Recommendad Polic
Rule ... . Rule Name Criteria Action
1 csc-lb-gre LOCATIONS Allow

csc-b-73-74-75

=>» Click “Save”

=>» and “Activate”.
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4.3 Filling the Form

After you buy the CSC, you will receive a Welcome Email with the indication about to fill the a
form with your data. Here a partial view of the form:

CSC Multiplex GRE - IP addressing required

CSC Multiplex - GRE o : 2y
E / (2 or 3) x GRE Tunnal | e
— ¥
bt | —_— Switch i Public IPs |
(L Leis Firewall o

=2 q ! /
| 2 TEN |
| Secondany Destination
1

Primary Dastinaton

3) DNS Servers

|, — : T-C 5) EXT-GW .

e 0. External ' S __..-.\\. m‘; | /;
4) EXT-First-IP/BitMask e

CSC Multiplex - GRE

Zscaler GRE - Example

Tunnel Source IP: |109.148.238.2 | GRE Public IP

Internal Range: 172.17.11.152-172.17.11.159

Primary Destination: [ 165.225.80.36 |

Internal Router IP: 2. 171 11.153/309

Internal ZEN IP: | 172.17.11.154/30

Secondary Destination: [165.225.76.36 |

Internal Router IP: 172.17.11.157/38

Internal ZEN IP: 172.17.11.158/30

The form is very easy to fill. The values that you need to ingress are:
1. Email
2. Company Name
3. Zscaler Company ID
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4. Zscaler Cloud Name
5. Your domain
6. Location Name

7. Internal Interface: First IP / Bitmask (Note: The CSC Multiplex GRE Cluster uses three
consecutive IPs. You need to ingress the first one) and Gateway.

8. External Interface First IP/Bitmask (Note: The CSC Multiplex uses four or six consecutive
IPs) and Gateway.

9. DNS Servers.
10. Syslog / SIEM Servers (optional)

11. Ingress your GRE tunnel information.

4.4 CSC files: OVA, URL/Bypass PAC example.

After you fill the form, you will receive an email containing links to download the following files:
(a) cmgXXXXX-Ib-v-Y-Z.ova : This is the Load Balancer of the CSC Multiplex GRE
(b) cmgXXXXX-1-v-Y-Z.ova: This is the first CSC GRE Single #1
() cmgXXXXX-2-v-Y-Z.ova: This is the first CSC GRE Single #2
(d) cmgXXXXX-3-v-Y-Z.ova: This is the first CSC GRE Single #3 (optional)

(e) cmgXXXX-url-bypass-pac.txt (Instructions to create the “Bypass PAC” to feed your CSCs
Bypass List. It also contains your Bypass PAC URL already configured on the CSCs)

Please, note that the CSC Multiplex GRE is composed of 3 or 4 Virtual Machines. The first virtual
machine is the load balancer. The other are the Connectors to Zscaler.
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5 Installing the OVA files in your Virtual Platform.

5.1 Networking required on your Virtual Platform

The following diagram shows the Networks “names” used by the CSC Multiplex GRE on the OVA
files. When importing the OVA file, you need to map this interfaces name accordingly.

ISOLATED
INTERNAL /

Important: You must create an internal network in your Virtual Platform for the only purpose of the
communication between the Load Balancer and the Connectors.
On the CSC VMs, the name of the Network that comes with the OVA file is “ISOLATED”

5.2 Deploying OVF files

We are going to show how to install the OVA file on Vmware. The process is very simple. Just
follow the defaults values and map the interfaces EXTERNAL, INTERNAL and ISOLATED
accordingly.

5.2.1 Deploying the Load Balancer

1. Go to vSphere, New Machine > Deploy VM from OVF or OVA ( on version 5.5 File >
Deploy OVF template)
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31 New virtual machine

- CECXIITITINS  Select creation type

2 Select OVF and VMDK files How would you like to create a Virtual Machine?
3 Select storage

4 License agreements " "
L — TTIIS option guides you through the process of creating a

5 Deployment options virtual machine from an OVF and VMDK files.

6 Additional settings Deploy a virtual machine from an OVF or OVA file

7 Ready to complete

Register an existing virtual machine

| Back | Next | Finish || Cancel

2. Select the OVA File and put the name for the Load Balancer

31 New virtual machine - cmg00001-Ib-v-1-0

+ 1 Select creation type Select OVF and VMDK files
Select the OVF and VMDK files or OVA for the VM you would like to deploy
3 Select storage
4 License agreements
5 Deployment options
6 Additional settings
7 Ready to complete

Enter a name for the virtual machine.

[ emgoo00L-b-v-1-4]

Virtual machine names can contain up to 80 characters and they must be unique within each ESXi instance.

* @ cmg00001-lb-v-1-0.0va

Back || Next . Finish Cancel
3. Select Storage

4. On Deployment Options, map the interfaces INTERNAL and ISOLATED accordingly:
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“#1 New virtual machine - cmg00001-Ib-v-1-0

+ 1 Select creation type Deployment options
' 2 Select OVF and VMDK files Select deployment options
+ 3 Select storage

b4 4 Deployment options .
Network mappings 1 | ISOLATED || ISOLATEDTDrCSCmuIUp\exer| X

5 Ready to complete

2 [wrernad] [ wet17219.00 |

Disk provisioning ® Thin © Thick

Power on automatically I«

Back Next | Finish || Cancel

Note: In this example the “ISOLATED” Network Name was mapped to
“ISOLATEDforCSCMultiplexer” and the “INTERNAL” to “Net-172-19-0-0”

5. Click Next > Ready to Complete > Finish

5.2.2 Deploying the CSC GRE Single (2 or 3 depending the model)
1. Go to vSphere, New Machine > Deploy VM from OVF or OVA ( on version 5.5 File >
Deploy OVF template)

31 New virtual machine

v QECEICITINER  Select creation type

2 Select OVF and VMDK files How would you like to create a Virtual Machine?

3 Select storage
4 License agreements - =

! G diiev Rtisl e This option guides you trough the process of creating a
5 Deployment options virtual machine from an OVF and VMDK files.

6 Additional settings Deploy a virtual machine from an OVF or OVA file
7 Ready to complete

Register an existing virtual machine

Back Mext Finish Cancel
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2. Select the OVA File and put the name for the CSC

%31 New virtual machine - cmg00001-1-v-2-4

+ 1 Select creation type Select OVF and VMDK files

2 Select OVF and VMDK files Select the OVF and VMDK files or OVA for the VM you would like to deploy

3 Select storage

R e Enter a name for the virtual machine.
5 Deployment options
6 Additional settings

7 Ready to complete |

[ emgooo01-1v-24
Virtual machine names can contain up to 80 characters and they must be unique within each ESXI instance.

X @ cmg00001-1-v-2-4.0va

Back | Next | Finish Cancel

3. Select Storage
4. On Deployment Options, map the interfaces EXTERNAL and ISOLATED accordingly:

$31 New virtual machine - cmg00001-1-v-2-4

+ 1 Select creation type Deployment options
' 2 Select OVF and VMDK files Select deployment options
+ 3 Select storage

b4 4 Deployment options
Network mappings

5 Ready to complete | [ ExtErNAL| | [Net192-158-1.0 | v
2 [1soLaTeD | [ISOLATEDICSCmultiplexer | v
Disk provisioning ® Thin © Thick
Power on automatically 7]

Back Next | Finish || Cancel

Note: In this example the “EXTERNAL” to “Net-192-168-1-0" and the “ISOLATED” Network
Name was mapped to “ISOLATEDforCSCMultiplexer”.
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5. Click Next > Ready to Complete > Finish

IMPORTANT : Repeat the process for CSC #2 (and CSC #3 if available)

© 2018 — Maidenhead Bridge Limited Page 17 of 57 Date 11/10/18



CSC Multiplex GRE — Admin Guide

6 Firewall Requirements

The CSC Mutliplex GRE can be connected directly to Internet Public IPs or behind a Firewall (NAT
is supported).

The most common scenario is to sit the CSC Multiplex GRE behind a Firewall.

6.1 Traffic Flow
The following diagram shows how the traffic flows when using the CSC Multiplex GRE:

ISOLATED
INTERNAL
-
Firewall
P S S AT e
DNS = é ZEN
g - Primary or Secondary

Direct to Internet

——————» ToZscaler
——'—> Bypass Traffic direct to Internet
(—- To Intemal DNS and Syslog

6.2 Internal and External Interfaces IPs

The CSC Multiplex GRE uses 3 x Internal IPs and 4 (or 6) x External IPs. Here a diagram showing
the IPs on the CSC Multiplex GRE:

INTERNAL (" )
(THREE consecutive IPs) ) 2. ) (1st) Extenal Interface #1
_) (2nd) Bypass Proxy Egress IP #1
(1s) GW A _> (3rd) Extemal Interface #2
_—> (2nd) VIP Proxy L ¢ _) (4th) Bypass Proxy Egress IP #2
_> (3rd) Bypass Proxy
Ib ‘h _) (5th) External Interface #3
__> (6th) Bypass Proxy Egress IP #3
. J
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6.3 External Interface: Firewall Configuration
On the External Interface of the CSC Multiplex GRE, the 1%, 3" and 5" IPs are used for traffic to

Zscaler, keepalives and some particular troubleshooting tests.

The 2™, 4™ and 6™ are used for the Bypass Proxy functionality.

6.3.1 NAT Rules

When the CSC Multiplex GRE is behind a firewall, the following NAT rules are required:

Item IPs to NAT | Public IP to use NAT Type Description
1 1%, 39, 5 Your Public IP (*) Static (1:1) Static NAT is required GRE Protocol 47.
2 2M 4t gh Any Public IP available Hide (N:1) Used for Bypass Proxy

(*) Some FW will require a dedicated IP when NATing GRE Protocol 47. We recommend to use a
dedicated Public IP.

6.3.2 Allow Rules

Item |Source IP |Destination IP Protocol |Ports Description
1 1% 39, 5" | Zscaler ZEN nodes |GRE (47) |N/A Allow GRE protocol 47 to Zscaler ZEN
(Primary and Nodes.
Secondary)
2 1%, 3% 5" | Zscaler ZEN nodes |TCP 80 Layer 7 Keepalives to Zscaler Nodes.
(Primary and
Secondary)
3 2M 4™ 6™ | All Internet TCP 80, 443 Used for Bypass Proxy to reach Internet
TCP High Ports: |sites. Port 80 and 433 are mandatory. High
1024 - 65535 Port are optional, but probably required. A
lot of Cloud Providers are using High
Ports today (SAP for example)
4 1%, 3¢ 5" Zscaler ZEN nodes |ICMP Used for testing purposes. Allow ping
(Primary and (echo — echo-reply) and traceroute (“time-
Secondary) and exceed”)
PAC File Servers
5 1%, 39 5% | Public DNS Servers |UDP 53 (Optional). Only needed if you are using

Public DNS.
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6.4 Internal Interface: Firewall Configuration

In the case you want to apply internal Firewall Rules, here the description of the IP and Ports in use
on the CSC Multiplex GRE.

The CSC Multiplex GRE uses 3 Internal IPs. Here the description and purpose of each one:

6.4.1 Gateway IP (1°' IP)

The first internal IP of the CSC Multiplex GRE is the Gateway IP. This IP is commonly used in two
scenarios:

1. Zscaler Cloud Firewall: You can send all ports and protocols to Zscaler cloud and to use this
Internal Cluster IP as default GW to internet.

2. No PAC file scenario: When you don’t want to implement PAC files or Explicit proxies on
your devices and you want to redirect all HTTP/HTTPS traffic to Zscaler, you can create a
rule in your FW redirecting all HTTP/HTTPS to the Internal Cluster IP

Item |Protocol Port / Service Used for:

1 All All Zscaler Cloud Firewall
To forward HTTP/HTTPS traffic (No PAC or Explicit
Proxy scenario)

6.4.2 VIP Proxy (2" IP)

The second internal IP of the CSC Multiplex GRE is the VIP Proxy. The VIP Proxy is a direct
connection to Zscaler proxies in the cloud through the GRE tunnels.

The VIP Proxy is used in two scenarios:
1. As a default proxy on the PAC file.

2. As Explicit proxy.

Item |Protocol Port / Service Used for:

1 TCP 80 /9400 Zscaler Web Security proxy

6.4.3 Bypass Proxy (3")

The Third internal IP of the CSC Multiplex GRE is the Bypass Proxy. The Bypass Proxy allows to
send specific configured URLs direct to the internet.

The Bypass Proxy is used in several scenarios like this ones:

1. When the destination Web Site requires the traffic coming from the local customer IP and
not Zscaler.
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2. When the customer wants to communicate direct with specific cloud services.

3. When the customer wants to communicate direct with specific trusted partners.

4. Etc.
Item |Protocol Port / Service Used for:
1 TCP 3128 Bypass Proxy.

6.4.4 Other traffic IN / OUT to / from internal IPs

Item |Protocol Port / Service Description
1 TCP (in) 22 Accepted on 1% and 3" Internal IP. Used to access to SSH
console.
2 |UDP (in/out) |53 DNS to Local DNS servers
3 | TCP (out) Defined by the Admin. Syslog Servers
Typical 514 or 601
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7 Powering up the CSC Multiplex GRE

1. Power on the all Virtual Machines. At the first boot, please wait 3 minutes to allow the Load
Balancer to acquire all CSC Single.

2. Open the VM Console (or SSH to GW IP)
When prompted, put the following username and password to login on the CSC Console:
Username: cscadmin

Password: maidenheadbridge

Note: SSH to the EXTERNAL interfaces is not allowed.

Welcome to Maidenhead Bridge - Cloud Security Connector - Multiplex
Last login: Thu Oct 11 ©7:57:18 2018 from 172.19.8.141

Maidenhead Bridge
Cloud Security Connector MULTIPLEX - Admin Console

Company : Maidenhead Bridge
Location : CSCMux@1l

C5C ID : cmgeeeel

Soft Version : 1.0

Please select an option by typing its number

Monitoring Tasks

1) Show Configuration and Status
2) Show Interfaces Traffic

3) SSH to balanced CSCs

4) Speed Test (Experimental)

CSC Admin tasks

5) AWS SSM Agent (Register or De-Register)
6) Change SSH Password

7) Change Timezone

Bypass Proxy
8) View Current Bypass List
9) Configure Bypass List

Log Information
18) View Current Month
11) View Last 6 Months
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3. Select 1) Show Configuration and Status check “Load Balancing” and “Tunnel” Status.

GENERAL INFORMATION

Company : Maidenhead Bridge

Location : CSCMux@l

CSC ID £

CSC date: Sun Oct ©8:45:56 BST 2018
Soft version : 1.8

INTERFACES INFORMATION

CSC1: Ext. Interface (ethe) IP: 192.168.1.170/24 | Ext. Bypass Proxy 192.168.1.171
. Interface (ethe) IP: 192.168.1.172/24 | Bypass Proxy 192.168.1.173 |
. Inter ethe) IP: 192.168.1.174/24 | ypass Proxy 192.168.1.175 |

Ex

) IP: 172.19.0.170/24 | Internal Gateway: 172.19.0.208 is Alive

VIP Proxy: 172.19.
Bypass Proxy:172.19.0.172:3128

DNS INFORMATION
: 172.19.08.133 is Alive
1 172.19.0.134 is Alive

ZSCALER INFORMATION
Zscaler Cloud: zscalerthree

LOAD BALANCING STATUS
Last change: Sun 14 Oct 08:42:
(UP) €sSCl is active
(UP)  CSC2 is active.
(UP) (€SC3 is active.

2018

CSC TUNNEL STATUS

CSC1 Primary tunnel is active
CSC2 Primary tunnel is active
CSC3 Primary tunnel is active

e: 5un 14 Oct 08:43:24 BST 2018
: 5un 14 Oct ©8:43:17 BST 2018
: 5un 14 Oct ©8:43:10 BST 2018

4. Congratulations! You are connected to Zscaler.

GW 192.168.1.240 is Alive
W 192.168.1.240 is Alive
GW 192.168.1.240 is Alive

5. Now, you can forward your traffic through the CSC using the following methods:

o PAC file (recommended): Traffic to Zscaler via VIP Proxy, Traffic direct to internet via

Bypass Proxy
o Explicit proxy: via VIP Proxy.

o All port and protocols: If you are using Zscaler Cloud Firewall, you can use the Internal

Cluster IP as your default Gateway to Zscaler and to send all ports and protocols.

Take a look of the next section for more details.
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8 How to Redirect traffic to the CSC

The objective of the Cloud Security Connectors of Maidenhead Bridge is to provide a simple
architecture, 100% proven that works, to connect to Zscaler.

Every member of the CSC family follows the principle of “three IPs” on the internal side:

* (I*IP) CSC Internal Interface: To be used as Default Gateway for internal devices
behind the CSC redirecting all ports and protocols to Zscaler when using Cloud Firewall.

e (2™ 1IP) VIP Proxy: This Virtual IP Proxy translates the packets directly to the Zscaler
proxy. To be used when PAC files are implemented or explicit proxy.

« (3" IP) Bypass Proxy: The Bypass Proxy enables a simple way to do Direct Bypasses to

Internet.

Here an illustration about this:

CSC GW IP: all Ports and
Protocols (Cloud Firewall) ) ? ; to Zscaler via Tunnel
VIP Proxy: to Zscaler Proxy ) 4___ J

Port 80, 9400, etc. )
—) to Internet directly

Bypass Proxy IP: Bypass _)

to Internet via URL Host ACLs
(Port 80, 433 and High Ports)

How to Redirect your traffic:

1. Sending all traffic using CSC (Internal Interface) GW IP as default gateway to internet for

all internal devices.

2. Using a PAC File: You can download a PAC file Example from here: Click here

Note: The Zscaler recommend method is to use PAC files over GRE tunnels.

8.1 Verifying that your reaching Zscaler.

8.1.1 Using a PC

Go to the following page: ip.zscaler.com from your PC
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C ® Notsecure | ip.zscaler.com w O O

f:zsca’er Connection Quality Zscaler Analyzer Cloud Health  Security Research

You are accessing this host via a Zscaler proxy hosted at London Ill in the
zscalerthree.net cloud.

Your request is arriving at this server from the IP address 165.225.16.71

The Zscaler proxy virtual IP is 165.225.16.36.

The Zscaler hostname for this proxy appears to be zs3-lon3-1c1-sme.

The request is being received by the Zscaler Proxy from the IP address 82.68.6.75
Your Gateway IP Address is 82.68.6.75

®

Maidenhead Bridge

® Would you like to Logout?

Your user name is: firstllastl@maidenheadbridge.com.

MNeed help? Contact our support team at +91-3000000000 support@maidenheadbridge.com.

This page shows:
(values of this example between brackets [])
¢ Cloud name: [Zscaler Three]
¢ Node: [London III]
e Zscaler internal values [165.225.16.71, 165.225.16.36, zs3-lon3-1c1-sme]
*  Your Gateway IP addresses [82.68.6.75. This is your public IP]
*  The name or logo of your organization [Maidenhead Bridge]

*  The Username (if Authentication was enabled on the location) [first1last]l@maidenheadbridge.com]
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8.1.2 Using the “Show Configuration and Status” menu of each CSC
GRE single.

The CSC Multiplex Console allow you to login to each CSC GRE Single for particular check of
statuses of each one:

Monitoring Tasks

1) Show Configuration and Status
2) Show Interfaces Traffic

3) SSH to balanced CsCs

4) Speed Test (Experimental)

CSC1

CsC2

) C5C3

4) Quit
Enter your choice:

y : Maidenhead Bridge
I nratinn + CSCMoxA1
CSC ID : cmgoeeel-1
CSC date: Sun 14 Oct ©9:04:31 BST 2018
Soft version : 2.4

248 is Alive
Alive

DNS INFORMATION
DNS S r (1) IP: 172.19.0.133 is Alive
DNS Server (2) IP: 172.19.0.134 is Alive

ZSCALER INFORMATION
Zscaler Cloud: zscalerthree
GRE tunnels egress Public IP: 82.68.6.73
Primary Tunnel:
ZEN Public IP: 165.:
Tunnel IPs
Secondary Tunnel:
ZEN Public IP: 165.225.76.39
Tunnel IPs (local/zen): 172.17.4.213 / 172.17.4.214

[TUNNEL STATUS
Primary Tunnel (reachability):
Layer 7 Keepalive is: Alive
C ZEN Tunnel IP is: Alive
Secondary Tunnel (reachabilit:
r 7 Keepalive is: Alive
GRE ZEN Tunnel IP is: Alive

Tunnel Status: Primary tunnel is active since: Sun 14 Oct ©8:43:24 BST 2018
IP.ZSCALER.COM PAGE STATUS
accessing this host via a Zscaler proxy hosted at London III in the zscalerthree.net cloud.

way IP Address is 82.68.6.73

3YPASS PROXY - EGRESS INTERFACE STATUS
3ypass Proxy Egress Interface 192.168.1.171 can reach test page (http://pac.zscalerthree.net)

JAWS SSM AGENT
IAWS SSM Agent was never registered

This menu also goes to http://ip.zscaler.com .
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8.2 Checking Connection Quality

8.2.1 Using a PC

On the page ip.zscaler.com, click on “Connection Quality” and “Start Test”

Cloud Performance Monitor Test @

This test will measure throughput as observed at applica
This session is valid for a sin

and ZEN whase IP s displayed below.
Lim.

ZEN IP

165.225.16.85

ZEN Name

753-lon3-1f3-sme.gateway.zscalerthree.net

Your IP

82.68.6.75

Your User Name

firstllastl@maidenheadbridge.com

Current Time

08:11 AM Sunday 14 October 2018 UTC

Latency Observed || 0.024 Seconds

Download Bandwidth || 68.92 Mbps

Upload Bandwidth |[ 18.39 Mbps

Latency is round trip time of & HT TP request between your machine and ZEN.

Download Results )

8.2.2 Using “Speed Test” menu of the CSC Multiplex GRE
The CSC runs the Speedtest.net (same test that you can run from the Web Page) on each of the

balanced CSC. This function is experimental due to we need to rely on third party tools.

With this tool, you can check the quality of each GRE tunnel individually.

Selection: 4

SPEED TEST
This is experimental. We are using third party tools. (Speedtest.net)
Results can be ipaccurate or none. The test takes a while

This test runs indivually on each balanced CSC

CSC1 Speed Test

Ping: 13.475 ms
Download: 68.61 Mbit/s
Upload: 2@.1@ Mbit/s

Csc2 Speed Test

Ping: 13.523 ms
Download: 71.02 Mbit/s
Upload: 20.49 Mbit/s

CSC3 Speed Test

Ping: 11.893 ms
Download: 78.07 Mbit/s
Upload: 28.69 Mbit/s
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9 CSC Multiplex GRE - Admin Console

The CSC Multiplex GRE has an Admin Console that allows to do different tasks. When you access
to the Admin Console, the following information appears on top:

Maidenhead Bridge

Cloud Security Connector MULTIPLEX - Admin Console

Company : Maidenhead Bridge
Location : CSCMux@l

CSC ID : cmg@eeel

Soft Version : 1.0

And you can select the following items:
Please select an option by typing its number

Monitoring Tasks

1) Show Configuration and Status
2) Show Interfaces Traffic

3) SSH to balanced CSCs

4) Speed Test (Experimental)

CSC Admin tasks

5) AWS SSM Agent (Register or De-Register)
6) Change SSH Password

7) Change Timezone

Bypass Proxy
8) View Current Bypass List
9) Configure Bypass List

Log Information
18) View Current Month
11) View Last 6 Months

e} Exit

9.1 Monitoring Tasks:

Monitoring Tasks
1) Show Configuration and Status
2) Show Interfaces Traffic

3) SSH to balanced CSCs
4) Speed Test (Experimental)
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9.1.1 Show Configuration and Status

1. Show Configuration and Status. This menu show all parameters configured on the CSC
Multiplex GRE and does several checks.

The following image shows in BLUE the Configuration information and in RED the statuses.

Selection: 1

GENERAL INFORMATION
Company : Maidenhead Bridge
Location : CSCMux@l

CSC ID :

INTERFACES INFORMATI
. Interfac 5 y 192.168.1.171 xt. GW 192.168.1.240 Alive
192.168.1.173 X GW 192.168.1.240 1s Alive
. Interface (eth®) IP: 1 168.1.17 4 - By 192.168.1.175 GW 192.168.1.240 Alive
hl) IP: 172.19.0.170, . A

DNS INFORMATION
DNS Server (1) IP: 172.19.0.
DNS Server (2) IP: 172.19.8.

ZSCALER INFORMATION
Zscaler Cloud: zscalerthree

LOAD BALANCING STATUS

Last change: Sun 14 Oct 88
(UP)  €SC1 is activ

(UP)  CSC2 is active

(UP)  €SC3 is activ

ISC TUNNEL STATUS

ISC1 Primary tunnel is active since: Sun 14 Oct 08:43:24 BST 2018
ISC2 Primary tunnel is active since: Sun 14 Oct ©8:43:17 BST 2018
ISC3 Primary tunnel is active since: Sun 14 Oct ©8:43:10 BST 2018

AWS SSM AGENT

nt is active (running) since Sun 2018-16-14 @ 7 BST; 43min ago
istration values: {"ManagedInstan "mi-0e5e3f99c21cf36 gion":"eu-

9.1.2 Show Interfaces Traffic

2. Show Interfaces Traffic: This selection shows the traffic information on all interfaces.

bmon 3.8

™ >
Bits 728.08Mb Packets 9 61. Abort Error
Carrier Error - 0 Collisions - e Compressed
Dropped
Frame Error e ea it
0 0 ICHPVG Errors 0 0 Ip6 Address Er
Ip6 Broadcast 0 0 Ip6 Broadcast 0 0 Ip6 Delivers
1Ip6 Forwarded - 0 Ip6 Header Err 0 1Ip6 Multicast
Ip6 Multicast 0 6
Ip6 Reasm/Frag
1p6 Too Big Er
IpeDiscards
Length Error 0 - Missed Error
0 Window Error

Lias
Sun Oct 14 69 Press 7 for help

© 2018 — Maidenhead Bridge Limited Page 29 of 57 Date 11/10/18



CSC Multiplex GRE — Admin Guide

IMPORTANT:
*  Press “q” to quit
*  Press “?” for help

9.1.3 SSH to balanced CSCs

Allows to get access to each balanced CSCs:

Enter your choice: 1
cscadmin@l192.0.2.1's password:

Welcome to Maidenhead Bridge - Cloud Security Connector GRE
Last login: Sun Oct 14 ©9:82:45 2018 from 192.08.2.30

Maidenhead Bridge
Cloud Security Connector GRE - Single - Admin Console

Company : Maidenhead Bridge
Location : CSCMux@l
CSC ID : cmg@@eel-1
Soft Version : 2.4

Please select an option by typing its number

Monitoring Tasks

1) Show Configuration and Status
2) Show Interfaces Traffic

3) Traceroute and Latency Test
4) Speed Test (Experimental)

CsSC Admin tasks

5) AWS SSM Agent (Register or De-Register)
6) Change SSH Password

7) Change Timezone

Bypass Proxy
8) View Current Bypass List
9) Configure Bypass List

Log Information
18) View Current Month
11) View Last 6 Months

e) Exit

selection: B

9.1.4 Speed Test

The CSC runs the Speedtest.net (same test that you can run from the Web Page) on each of the
balanced CSC. This function is experimental due to we need to rely on third party tools.

With this tool, you can check the quality of each GRE tunnel individually.
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Selection: 4

SPEED TEST

This is experimental. We are using third party tools. (Speedtest.net)
Results can be inaccurate or none. The test takes a while

This test runs indivually on each balanced CSC

CSC1 Speed Test

Ping: 13.475 ms
Download: 68.61 Mbit/s
Upload: 208.10 Mbit/s

Csc2 Speed Test

Ping: 13.523 ms
Download: 71.62 Mbit/s
Upload: 20.49 Mbit/s

CSC3 Speed Test

Ping: 11.893 ms
Download: 70.67 Mbit/s
Upload: 20.69 Mbit/s

9.2 CSC Admin Tasks

CSC Admin tasks
5) AWS SSM Agent (Register or De-Register)

6) Change SSH Password
7) Change Timezone

5. AWS SSM Agent (Register or De-Register)
6. Change SSH Password: Allows to change the password of the CSC.

7. Change Timezone: In case if needed, you can select your Timezone here.

9.2.1 AWS SSM Agent (Register | De-Register)

One of the main functionalities added after version 2.0 is that the CSC GRE can be integrated with
the Amazon Cloud (AWS). The CSC is now part of the Cloud.

Amazon AWS offers a Free Tier Account (https://aws.amazon.com/free) with some product free for
1 year and others always free. You need to create or to have an AWS account to manage the CSC.
AWS allows to manage for free up to 1000 managed instances.

The steps required to add the CSC are two:
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Activations > Create Activation

Create Activation

Creating a new activation allows you to generate a code which can be used to register a run command agent on instances. Specify the details below to create a new activation:

Activation description CAS00027
Instance limit 10 [i]

IAM Role Name* @ Use the system created default command execution role
(AmazonEC2RunCommandRoleForManagedinstances)

Select an existing custom IAM role that has the required permissions

Activation expiry date 2017-11-07T00:00+00:00 i)

Default Instance name | CAS00027 | [i]

1. From your EC2 Console, go to SYSTEMS MANAGER SHARED RESOURCES >
Activations > Create an activation

Note: We recommend to create an Activation per CSC and on “Default instance name” to put the
name of the CSC ID or the name of your “Location” for easy identification.

When you click “Create an Activation” you will receive the following information:

Activations > Create Activation

Create Activation

& Success
You have successfully created a new activation (b4e8d912-223e-421d-8efe-e84dalb10edb ).
Your activation code is listed below. Copy this code and keep it in a safe place as you will not be able to access it again.

Activation Code VvAOOVjkxHghls8viUeF

Activation ID  b4e8d912-223e-421d-8efe-e84dalb10e4b

You can now install amazon-ssm-agent and manage your instance using Run Command. Learn more

View result

Please, keep copy this values on a safe place. You will need this to register the AWS SSM client on
the CSC.

2. From the CSC Admin Tasks Menu, select “5) AWS SSM Agent (Register or De-Register)”

CSC Admin tasks
5) AWS SSM Agent (Register or De-Register)

6) Change SSH Password
7) Change Timezone
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Selection: 8

The SSM Agent is inactive (dead) since Mon 2017-10-16 17:22:55 BST; 43min ago

Do you want to Register (start) the AWS SSM Agent (y/n) |}

({39

Ingress “y

You will asked for the Activation Code, Activation ID and AWS Region where to register the CSC.
(Check your AWS URL https://eu-west-1.console.aws.amazon.com/ec2/v2/home?region=eu-west-
1#)

Please, ingress Activation Code, Activation ID and Region (example: eu-west-1)
ctivation Code :VvAOBVjkxHghls8v/UeF

ctivation ID :b4eB8d912-223e-421d-8efe-e84dabbloedb

Region :eu-west-1]]

If the AWS SSM agent is registered successfully you will receive the following message:

2017/10/16 18:11:33 Failed to load instance info from vault. RegistrationKey does not exist.
2017-10-16 18:11:48 INFO Successfully registered the instance with AWS SSM using Managed instance-id: mi-0180217713cd99941

Done! You have the CSC integrated with AWS now with the instance-id “mi-xxxxxxxxx” (mi-
0100217713cd99941” in this case).

Go to your EC2 Console (SYSTEMS MANAGER SHARED RESOURCES > Managed Instances)
and you will be able to see your CSC registered as an instance:

aws, Services v Resource Groups v *

Indle Tasks - P Create Association Setup Inventory Resource Data Syncs | Actions v

Q, Filter by attributes
lumes
Name Instance ID Ping status Platform Type Platform Name Agent Version IP Address Computer Name
1apshots
CAS00027 mi-0100217713cd9. @ oOniine Linux Ubuntu 22300 192.168.1.40 CAS00027

9.2.1.1 Checking the status of the AWS SSM agent
The “Show Configuration and Status” Menu shows the status of the AWS SSM agent at the bottom.

AWS SSM AGENT
AWS SSM Agent is active (running) since Mon 2817-10-16 18:11:48 BST; 8min ago

Registration values: {"ManagedInstancelID":"mi-0100217713cd99941","Region":"eu-west-1"}

IMPORTANT: Go to Appendix B to learn how to “Run Commands” from the AWS console to
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monitoring the CSC and Update Bypass Lists.

9.2.2 Change SSH Password

From this menu, you can change the SSH Password of the Admin Console.

9.2.3 Change Timezone

The CSC automatically takes the time and timezone from the virtual platform but you can change if
it is not correct or you want another value.
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9.3 Bypass Proxy

The Bypass Proxy allows you to connect certain allowed Domains direct to Internet. By default, all
domains are blocked and you need to insert the domains that you want to allow to go direct.

Bypass Proxy
8) View Current Bypass List

9) Configure Bypass List

Important about domains and wildcards. The CSC uses the same nomenclature than Zscaler, but the
PAC files are different. Please not the following examples:

CSC PAC file

Www.example.com Www.example.com

.example.com * example.com

Important! Be careful not to create an “Open Proxy” setting something like “.com” that will
allow to pass all domains ending on “.com”

9.3.1 View Current Bypass List

This commands shows the current domains and subdomains allows to go direct to Internet

9.3.2 Configure Bypass List

In order to configure the Bypass List you have two options:

Selection: 9

Please, select method to configure Bypass List

1) Auto - Bypass PAC URL
2) Manual

3) Quit

Enter your choice: [}

9.3.2.1 1) Auto - Bypass PAC URL

This is the recommended method to use. You need to create a “Bypass PAC file” on your Zscaler
console. The CSC will read the “Bypass List” from the “Bypass PAC file”.

By default, the CSC has configured this PAC URL.:

http://pac.<yourcloudname>.net/<yourdomain>/cscbypass.pac
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* You can change this URL via console menu. You can use an internal URL if you want.

The idea of the “Bypass PAC file” is to act a central repository of all bypasses required. Moreover,
if you are managing the CSCs using AWS, you can update all CSCs in your network doing one
AWS Run Command.

Example of “Bypass PAC file”

function FindProxyForURL(url, host) {
var bypassproxy="PROXY 1.1.1.1:3128; PROXY 2.2.2.2:3128";

//* CSC bypass*/
if ((shExpMatch(host, "*.firstdomain.com")) ||

(shExpMatch(host, "www.fulldomain.co.uk")) ||
(shExpMatch(host, "*.anotherdomain.com")) ||
(shExpMatch(host, "*.salesforce.com”)) ||
(shExpMatch(host, "*.lastdomain.com"))){

return bypassproxy

}

}

Important Note: It is mandatory to use this function and format. Feel free to add lines but don’t
change the format. We recommend to start filling the first line and the last line. Use middle lines
for copy/paste.

Note: You can use the lines in bold to copy/paste in your production pac file. Please, pay attention
to replace 1.1.1.1 and 2.2.2.2 for your real Bypass proxy addresses.

Bypass Proxy on the Zscaler Console:

Edit PAC File x

PAC File
Description PAC File Name
| CSC Bypass Proxy | | cschypass.pac
Domain Obfuscate URL
| malidenheadbridge.com - | m
PAC File Contents
1 function FindProxyForURL{url, host) [
2 var bypassproxy="PROXY 16.1.1.1:3128; PROXY 19.2.2.2:3128";
3
4 J* €SC bypass*/
5 if ((shExpMatch(host, “*.Firstdomain.con™)) ||
] (shExpMatch(host, “www.fulldomain.co.uk™)) ||
7 (shExpMatch(host, "*.anotherdomain.con”)) ||
8 (shExpMatch(host, "*.salesforce.com™)) ||
9 (shExpMatch(host, "*.lastdomain.com™))){
18 return bypassproxy
11 1
H
=1
Save Cancel | Delete |

For example, here is a production pac file with the bypasses added:
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Edit PAC File x

PAC File
Description PAC File Name
pacha | pacha.pac
Domain Obfuscate URL

| maidenheadbridge.com - |

PAC File Contents

36 wvar bypassproxy="PROXY 172.19.0.217:3128; PROXY 192.168.1.220:3128"; -

37

38 /* €5C bypass*/

39 if ((shExpMatch(host, “*.firstdomain.com™)) ||

a8 (shExpMatch(host, ™www.fulldomain.co.uk™)) ||

41 (shExpMatch(host, “*.anotherdomain.com™)) ||

42 (shExpMatch(host, "*.salesforce.com™}) ||

43 (shExpMatch(host, "*.lastdomain.com™)))[

44 Seturn bypassproxy

46

a7 /I ©) Use Zscaler for : www.company.com {(overwriting b) sentence *.company.com)

48 if ((shExpMatch{host, “www.company.con”))){

49 return cscvipha

58

51

52 // b) Bypass Internal domains and subdomains: intranet.company.com, *.mail.company.r

53

54 if ((shExpMatch(host, “intranet.company.com™)) ||

55 (shExpMatch(host, "*.company.com”))

56 (shExpMatch(host, "*.mail.company.net™)}){

57 return "DIRECT";

38 1 v

59 L3
Verify

Cancel [ Delete |

Important: Proxy Bypass is reachable only on port TCP 3128

Configuration Steps:

1. Select 1) Auto — Bypass PAC URL, you are invited to change the Bypass PAC URL, here an
screenshoot:

Enter your choice: 1

Current Bypass PAC URL configured is: http://pac.zscalerbeta.net/maidenheadbridge.com/cscbypass.pac

Do you want to change Bypass PAC URL? (y/n)? y

Please, ingress Bypass PAC URL
Bypass PAC URL:http://pac.zscalerbeta.net/maidenheadbridge.com/cscbypass.pacl]]

2. The next step will show the Bypass URL in use and will invite to update the list:

Your current Bypass PAC URL is: http://pac.zscalerbeta.net/maidenheadbridge.com/cscbypass.pac

Do you want to refresh Bypass List? (y/n)? ]
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Do you want to refresh Bypass List? (y/n)? y

This is your current Bypass List

.firstdomain.com

www . Tulldomain.co.uk
.anotherdomain.com
.salesforce.com
.lastdomain.com

Do you want apply changes? (y/n)? |j

3. The CSC retrieves the list of bypasses from the Zscaler cloud

({3

4. Press “y” and you will receive a notification or error message.

Do you want apply changes? (y/n)? y

Bypass List updated sucessfully

5. Verify the list using menu 11)
This is the list of current Domains configured:
.firstdomain.com

www . fulldomain. co.uk
.anotherdomain. com

.salesforce.com
.lastdomain. com

IMPORTANT: Go to Appendix B to learn how to Update Bypass List from AWS
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9.3.2.2 2) Manual

If you want to update manually your bypass list, follow this steps

1. Select Option 2)

Enter your choice: 2

Please, read the instructions carefully:
You are going to edit the list using NANO editor
The following formats are accepted:

Full Domains: ‘www.example.com’
Wildcard for subdomains: '.example.com' - This will allow all subdomains of example.com

To save, press CTRL-X and 'Yes'

Paid attention to ERROR messages if any. ERRORs must be corrected before to continue

Do you want to continue? (y/n)? |

({3

2. Ingress “y

GNU nmano 2.5.3 File: domains Modified

.firstdomain.com

www . Tulldomain.co.uk
.anotherdomain. com
.salesforce.com
.lastdomain.com

weww .manualentry. com
.manualwithsubdomains. co. uklj

B¢ Get Help WY Write Qut @Y Where Is B Cut Text W Justify g Cur Pos
B Exit M Read File Y Replace Y Uncut Text g To Spell gl Go To Line
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3. Add/ Delete / Modify your full domains and subdomains
4. Please, CTL+X and “Yes” (and after next prompt Enter) to Save

5. The modified Bypass List will be displayed.

This is your current Bypass List

.firstdomain.com

www. fulldomain.co.uk
.anotherdomain. com
.salesforce.com
.lastdomain.com
www.manualentry.com
.manualwithsubdomains.co.uk

Do you want apply changes? (y/n)? |j

6. Apply Changes (y) or discard (n). If “y” you will receive the following message:

Do you want apply changes? (y/n)? y

Bypass List updated sucessfully
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9.4 Log Information
This section shows the logs on the CSC Multiplex GRE.

It is possible to view the current month and the last 6 months logs.

Log Information
View Current Month
View Last & Months

08:48:27 : (MHB-CSC) (UP) CSC Multiplex was powered ON: Sun 14 Oct ©8:48:27 BST 2018

(MHB-CSC) (DOWN) ALL CSC are inactive since: Sun 14 Oct @ 27 BST 2018
(MHB-CSC) (DOWN) CSC1 is NO active since: Sun 14 Oct ©88:4 4 BST 2018
(MHB-CSC) (UP) CSC2 1is : Sun 14 Oct ©8:41:44 BST 2018 using primary
(MHB-CSC) (UP) CSC3 1is acti L Sun 14 Oct ©8:41:44 BST 2018 using primary
(MHB-CSC) (UP) €SC1 is acti ince: Sun 14 Oct € 6 BST 2018 using primary
4 (MHB-CSC) (UP) CSC2 is active since: Sun 14 Oct 46 BST 2018 using primary
08:42:46 : (MHB-CSC) (UP) CSC3 is active since: Sun 14 Oct ©8:42:46 BST 2018 using primary

9.4.1 SysLog Server information example:
This example show the initial Power On of a CSC Multiplex GRE .

cmgeeeal o | ) (UP) CSC Multiplex was powered ON: Sun 14 Oct ©8:40:27 BST 2018
:27 cmgfeeel | ) (DOWN) ALL €SC are inactive since: Sun 14 Oct @ :
4 cmgeeenl H | ) (DOWN) CSC1 is NO active since: Sun 14 Oct 08:41:44 BST 26
4 cmg@eeel H | ) (UP) CsC2 is active sun 14 Oct 08:41 BST 2018 using primary
ive si : Sun 14 Oct € BST 2018 using primary

4 cmgBeeel | ) (UP) CSC3 is & :
6 cmgoeeel | ) (UP) CSC1 is & i Sun 14 Oct ©8:42:46 BST 2018 using primary
6 cmgeeeeal o | ) (UP) CSC2 is a i Sun 14 Oct ©8:42:46 BST 2018 using primary
6 cmgfeeAl : | ) (UP) C5C3 is active since: Sun 14 Oct 08:42:46 BST 2018 using primary
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10 Checking full visibility of the transaction on the
Zscaler GUI

The most important thing when doing tunnels to the Zscaler Cloud is to do not NAT the connections
to the cloud. This allows to see the internal IPs on the Zscaler logs. Having visibility of the internal
IPs is a must for full Security and Control.

10.1 Web Logs
Go to Analytics > Web Insights

Click Logs and Filter by Location [cas00016 in this example is the name of the Location]

Current Day: 9/6/2017

Location x
cas00016 - |
| Add Filter - |

Apply Filters:

Web Insights
No. Logged Time User URL Policy Action URL Category Client IP Server IP
158 Wednesday, September 06, 2017 7:24:20 ... first1last] @maidenheadbri... www.bbc.co.uk:443 Allowed Mews and Media 172.19.0.140 212.58.246.93
159 Wednesday, September 06, 2017 7:24:20 ...  firstllastl®maidenheadbri... edigitalsurvey.com:443 Allowed Professional Services 172.19.0.140 46.236.9.36
160 Wednesday, September 06, 2017 7:24:20 ...  first1last] @maidenheadbri... edigitalsurvey.com:443 Allowed Professional Services 172.19.0.140 46.236.9.36
161 Wednesday, September 06, 2017 7:24:20 ...  firstllast1®maidenheadbri... edigitalsurvey.com:443 Allowed Professional Services 172.19.0.140 46.236.9.36
162 Wednesday, September 06, 2017 7:24:20 ...  firstllastl @maidenheadbri... homepage.files.bbci.co.uk443 Allowed Mews and Media 172.19.0.140 172.227.98.43
163 Wednesday, September 06, 2017 7:24:20 ...  firstllasti@maidenheadbn... sslbbc.co.uk:443 Allowed Mews and Media 172.19.0.140 212.58.244.114
164 Wednesday. September 06, 2017 7:24:20 ...  firstllast1@maidenheadbn... search.files.bbci.co.uk:443 Allowed Mews and Media 172.19.0.140 172.227.98.43
163 Wednesday. September 06, 2017 7:24:20 ...  firstllast1@maidenheadbn... nav.files.bbcico.uk:443 Allowed Mews and Media 172.19.0.140 172.227.98.43
166 Wednesday, September 06, 2017 7:24:20 first1lastl@maidenheadbr... static.bbc.co.uk:443 Allowed Mews and Media 172.19.0.140 172.227.98.43
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As you can see, you have full visibility of the Client IP [172.19.0.140 in this case]

More in detail:

Client IP Server IP

172.19.0.140 212.58.246.93
172.19.0.140 46.236.9.36
172.19.0.140 46.236.9.36
172.19.0.140 46.236.9.36

172.19.0.140 172.227.98.43

10.2 Firewall Logs

Same than before, with the CSC you will have full visibility on Firewall Logs of your internal IPs.
Go to Analytics > Firewall Insights

Click Logs and Filter by Location [cas00016 in this example is the name of the Location]

Last 1 Minute: 9/6/2017 7:42:35 AM - 9/6/20...

Location x
| cas00016 - |
| Add Filter - |

Apply Filters

Firewall Insights

Client Source IP | Server Destination IP

16 Wednesday, September 06, 2017 7:42:39 ... None first1last1@maidenhead... cas00016 172.19.0.140 8.64.4 Default Firewa... DNS DNS
17 Wednesday, September 06, 2017 7:42:42 ... None first1last1®@maidenhead... cas00016 172.19.0.140 91.190.217.135 Default Firewa... TCP TCP
18 Wednesday, September 06, 2017 7:42:43 ... None first1last1@maidenhead... cas00016 172.19.0.140 157.55.56.164 Default Firewa... TCP TCP
19 Wednesday, September 06, 2017 7:42:49 ... None first1last1®@maidenhead... cas00016 172.19.0.140 91.190.217.135 Default Firewa... TCP TCP
20 Wednesday, September 06, 2017 7:42:56 ... None first1last1@maidenhead... cas00016 172.19.0.140 74.125.133.188 Default Firewa... TCP TCP
P4 Wednesday, September 06, 2017 7:43:00 ... None first1last1®@maidenhead... cas00016 172.19.0.140 91.190.217.135 Default Firewa... TCP TCP
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More in detail:

Client Source IP Server Destination IP

172.19.0.140 g.8.4.4
172.19.0.140 91.190.217.135
172.19.0.140 157.55.56.164
172.19.0.140 91.190.217.135
172.19.0.140 74.125.133.188
172.19.0.140 91.190.217.135
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11 Troubleshooting

11.1 If the tunnels are not connecting

The “Configuration and Status” menu is providing all information required and is doing all checks
for you. Start doing this command to verify everything, from configuration to reachability of
gateways, DNS and Zscaler nodes.

According our experience, the most common issues are related to this:

1. GRE NAT and firewall rules in general. GRE is not TCP. GRE is a protocol like TCP
(number 47). In order to do NAT you will probably required to do a STATIC SOURCE
NAT and to allow protocol 47 in both directions.

2. Are Vmware interfaces are properly mapped?

3. Are the configuration values correct? Check all values again using “Configuration and

Status” menu.
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11.2 Proxy Bypass

11.2.1 How to check if the Proxy Bypass is active?

Open a browser, type the IP of your proxy bypass plus (:) proxy port 3128, here the format:
http://<your bypass proxy ip>:3128

For example: http://172.19.0.217:3128/

and you will received the following page:

< C | ® 172.19.0.217

Cloud Security Connector

Cloud Security Connector (C5C ID: cas00101) says:

Bypass Proxy is active

Generated Sat, 23 Dec 2017 0B:25:25 GMT by casoD101

Please, note that the CSC ID is showed in this notification. This helps administrators to identify the
CSC in case is needed.

11.2.2 If you added the bypass in the PAC but forgot to update the

CSC
In the case the bypass Domain Host is in your production PAC file but not configured on the CSC,
the user will received the following message:
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< C | ® www.primerdomain.com

Cloud Security Connector

Error Message: The requested URL could not be retrieved

Cloud Security Connector (CSC ID: cas00101) says:

The URL http://www.primerdomain.com/ you are trying to reach is in your "PAC file Bypass Proxy List" but not configured on the Cloud Security Connector ID: cas00101

Please, contact your organization IT Team or Help Desk

Generated Sat, 23 Dec 2017 08:32:48 GMT by cas00101

11.3 PAC file troubleshooting

Please, for all this test use “Google Chrome”

11.3.1 How to check what PAC file URL is applied?
Using Google Chrome, go to:

chrome://net-internals/#proxy

You will receive the following screen:

< & | ® Chrome | chrome://net-internals/#proxy

capturing events (1973)

Capture
Im port | Re-apply settings |
Proxy Effective proxy settings
Events PAC script: http://pac.zscalerbeta.net/JT5LOFYFOL15N/pacha.pac
Timeline
NAS
11.3.2 How to Check if the Domain destination is using VIP Proxy or

Bypass Proxy?
Using Google Chrome, do the following steps:

1. Open in one tab the domain you are looking for. For example: www.salesforce.com

2. Open another tab and type: chrome://net-internals/#events
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3. On the Sort & Filter field (?) type: <domain> & http_stream_job_controller. In this example
we are going to put salesforce.com & http_stream_job_controller

4. Refresh the page on the tab that contains www.salesforce.com

5. Go back to the events tab and click on any event that this
HTTP_STREAM_JOB_CONTROLLER and contains the <domain> at the beginning

In the next example, you can see that www.salesforce.com is:

* Matching the CONFIGURED proxy string "PROXY 172.19.0.217:3128;PROXY
192.168.1.220:3128" of the PAC file in use.
(PROXY_SERVICE_RESOLVED_PROXY_LIST, --> pac_string = "PROXY
172.19.0.217:3128;PROXY 192.168.1.220:3128" )

* USING the proxy "PROXY 172.19.0.217:3128" (--> proxy_server = "PROXY
172.19.0.217:3128")

/ @ CRM Software & Cloud X ) [} chrome:u/net-internals/ X

< cle Chrume‘ chrome://net-Internals/#events |

(18028)

?) |salesforce.com & hittp_stream_job_controlier 76 of 1096
= = . 7211:HTTP_STREAM JOB CONTROLLER
- 7207 | URL_REQUEST p: alesforce.com/etc/clientc P i init.
oxy : Start Time: 2017-12-23 09:29:13.030
Events I | 7211 HTTP_STREAM JuB,mNTRuLLE# P “‘Mﬁ'\'ce.\.um]Eu [
t=56413 [st=0] +HTTP_STREAM_JOB_CONTROLLER [dt=2]
Timeline 7221| URL REQUEST https:#/dc.ads.linkedin.com/collect/?fmt=gif&pid=543 “-> Is preconnect - false
. - --> url = "https://ww.salesforce.con/etc/clientcontext/sfdc-waw/content/jct
DNS 7224] URL REQUEST P O s t=56413 [st=0]  HTTP STREAM JOB CONTROLLER BOUND
Sockets 7228 URL_REQUEST https:t/www.facebook com/tr2id=1424193781160198& --> source_dependency = 7267 (URL_REQUEST)
t=56413 [st=0]  +PROXY_SERVICE [dt=1]
Alt-Svc 7244 URL_REQUEST https://go.affec.tv/if5575ca3d95cfad000ce63d 1d t=56414 [st=1] +HOST_RESOLVER TMPL_REQUEST [dt=0]
--> address_family = 1
7262| URL_REQUEST https:/Awww. facebook com/tr7id=14241937811601988 --> allow cached response = true
--> host = "www.salesforce.com:80"
7281 | URL_REQUEST hitps:#/omtr2.partners.salesforce.com/b/ssfsalesforce s is speculative - false Configured
_ “onfi
- | t=56414 [st=1] HOST RESOLVER IMPL CACHE HIT
7285| URL_REQUEST hitps:#/d.adroll.comipixelf2ZCUYMULNSAQRHP3FASE: " address List - ["96.43.148.26:86","96.43.149.26:80"] W
Modules 2T D hitpssigoogleads.g Jick-net/pagead t=56414 [st=1] -HOST RESOLVER_IMPL_REQUEST
o N t=56414 [st=1] PROXY_SERVICE_RESOLVED_PROXY_LIST
Domain Security Policy 7293 | HTTP_STREAM _JOB_CONTROLLER | https://omtr2.partners.salesforce.comib/ss/salesforcer --> pac_string = "PROXY 172.19.0.217:3128;PROXY 192.168.1.220:3128"
t-56414 [st=1] -PROXY SERVICE
7295 | HTTP_STREAM JOB_CONTROLLER | https://g 9 lick.net/pag t-56414 [st-11 [HTTP STREAM J0B CONTROLLER PROXV SERVER RESOLVED | 4 [p usc‘
= = --> proxy server = "PROXY 172.19.8.217:3128"
7315 | URL REQUEST https:#/pnapi.invoca.net/1/api/2014-09-01/map_numb t-56414 [st=1]  HTTP STREAM REQUEST STARTED J0B

--> source_dependency = 7212 (HTTP_STREAM_JOB)

7318 HTTP_STREAM_JOB_CONTROLLER | https://pnapi.invoca.net/1/api/2014-09-01/map_numbe 56415 [st=2] —HﬁPﬁSTREAMijDEicﬂNTHOLLER

In this example, www.salesforce.com is using the Bypass
INTERFACES INFORMATION
External Interface (ethe) IP: 192.168.1.215/24 | External Gateway: 192.168.1.254 is Alive
Internal Interface (ethl) IP: 172.19.8.215/24 | Internal Gateway: 172.19.8.208 is Alive

VIP Proxy: 172.19.0.216
Bypass Proxy: 172.19.0.217

Please, remember that Bypass Proxy uses port tcp 3128.

Example of a domain host that is using the VIP Proxy:

Following the previous steps, we are going to inspect the domain “www.google.co.uk”
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/ & Google % Y [ chromes#inet-internals/ X \
y -
&« i ‘ ® Chrome | chrome://net-internals/#events
capturing events (42857)
Capture (?) |google.co.uk & hitp_stream_job_controller 46 of 2409
Import o s r o 8665: HTTP_STREAM_JOB_CONTROLLER
Prow ource Type escription http google.co ient=ch j&gs_ri=ch =t&q=gRoit=1&cp=18U
o 8662 URL_REQUEST p google.co.uk h2client=chr Start Time: 2017-12-23 09:57:17.096
Events
4| 8665 HTTP_STREAM JOB_CONTROLLER http: google.co.ukic haclient=chrt t=1740479 [st= @] +HTTP STREAM JOB CONTROLLER [dt=127]
Timeline --> is_preconnect = false
e 8673 URL_REQUEST p google.co.uk hclient=chr --> url = "https://www.google.co.uk/complete/search?client=chrome-omni
DNS ; t=1746479 [st= @]  HTTP STREAM JOB CONTROLLER BOUND
Sockets 8676 HTTP_STREAM_JOB_CONTROLLER http: google.co.uk h2client=chr P oince dovonduncy = 8652 {URL REQUEST)
. 8678 URL_REQUEST p—— hcliontchr t=1740479 [st= ©] +PROXY_SERVICE [dt=13]
Alt-Svc - > . t=1740479 [st= 0] +HOST_RESOLVER_IMPL_REQUEST [dt=12]
N 8681 | HTTP_STREAM_JOB_CONTROLLER | htp: goagle.co.L heclient=chr --> address_family = 1
HTTP/2 --> allow_cached_response = true
QUIC 8973 | URL_REQUEST ps goog| L hclient=chr --> host = "www.google.co.uk:80"
L --> is_speculative = false
Ca 8976 HTTP_STREAM_JOB_CONTROLLER | http: google.co.. h2client=chr £=1740480 [st= 1] HOST_RESOLVER_IMPL_CREATE_JOB
- ; £=1740480 [st= 1] HOST_RESOLVER_IMPL_JOB_ATTACH
Modules 8983 URL_REQUEST P google.co. haclient=chr --> source_dependency - 8666 (HOST_RESOLVER_IMPL_JOB)
t=1740491 [st= 12] -HOST_RESOLVER IMPL REQUEST
I ol I = | _IMPL _E
Domain Security Policy G I ST O e i google.co. necientEenr £=1740492 [st= 13] PROXY_SERVICE RESOLVED PROXY LIST
Bar th 8988 URL_REQUEST P google.co.L h2client=chr --> pac_string = "PROXY 172.19.6.216:80;PROXY 192.168.1.219:80"
é ¢ £=1740492 [st= 13]  -PROXY_SERVICE
Prerender 8991  HTTP_STREAM_JOB_CONTROLLER | http: google.co.L hclient=chr £=1740492 [st= 13]  HTTP STREAM JOB CONTROLLER PROXY SERVER RESOLVED
) ) --> proxy server = "PROXY 172.19.0.216:80"
8993 URL_REQUEST p: google.co.L hclient=chr £=1740492 [st= 13]  HTTP STREAM REQUEST STARTED JOB
; --> source_dependency = 8667 (HTTP_STREAM_JOB)
8996 HTTP_STREAM_JOB_CONTROLLER | htp: google.co.L hclient=chr t-1746666 [5t-127] -MTTP STREAM JOB CONTROLLER

In this case:
* PROXY_SERVICE_RESOLVED_PROXY_LIST
--> pac_string = "PROXY 172.19.0.216:80;PROXY 192.168.1.219:80"
e HTTP_STREAM_JOB_CONTROLLER_PROXY_SERVER_RESOLVED
--> proxy_server = "PROXY 172.19.0.216:80"

In this example, www.google.com is using the VIP prox

INTERFACES INFORMATION

External Interface (ethe) IP: 192.168.1.215/24 | External Gateway: 192.168.1.254 is Alive
Internal Interface (ethl) IP: 172.19.0.215/24 | Internal Gateway: 172.19.0.200 is Alive

VIP Proxy: 172.19.0.216
Bypass Proxy: 172.19.0.217

Please, remember that VIP Proxy uses port tcp 80 or 9400.
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12 Maidenhead Bridge Contact Information
Website: www.maidenheadbridge.com

Sales enquiries: sales@maidenheadbridge.com

Support: http://support.maidenheadbridge.com
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13 Appendix A - PAC File Example

Click here to obtain a PAC file example that will help to redirect traffic to Zscaler and to do Local
Bypasses or Direct bypasses to Internet.
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14 Appendix B - “Run Commands” from AWS to
monitor the CSC

When you have your CSC registered on AWS as “managed instance” you can execute the
“Monitoring Tasks” and also to “Update Bypass List”. This is particular important if you have
several CSC and you want to update all in one task.

14.1 Documents

To execute “Run Commands” you need to have “Documents”. “Documents” contains a series of
commands to execute. For simplicity purposes, we provide the “Documents” required for the
operations of the CSC.

To obtain the Documents required you can open a ticket to http://support.maidenheadbridge.com
(indicating your AWS Account ID) or to create them manually Copying/Pasting the information that

follows.

14.1.1 Creating a Document
From EC2 Console > Systems Manager Shared Resources > Documents — Click “Create

Document”

Put the “Name” , “Document Type” = Command and fill “Content”

aws Services +  Resource Groups v %

Documents > Create Document

Specify the following parameters to create a document

Name* MHB-CSC-ShowConfigurationAndStatus [i]
Document Type Command -

Content*

G
MiB - (SC - Show Configuration and Status”,

» AWS Command Line Interface command

[ELEEN  Create Document

Click “Create Document”
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14.1.2

List of Documents

Please, create the “Documents” using this values:

Name

MHB-CSC-ShowConfigurationAndStatus

Content

{
"schemaVersion":"2.2",
"description":"MHB - CSC - Show Configuration and Status",
"mainSteps":[
{
"action":"aws:runShellScript",
"name":"Runscripts",
"inputs":{
"runCommand":[
"/home/cscadmin/aws-mt4"

Name

MHB-CSC-SpeedTest

Content

{

"schemaVersion":"2.2",
"description":"MHB - CSC - Speed Test",
"mainSteps":[
{

"action":"aws:runShellScript",

"name":"Runscripts",

"inputs":{

"runCommand":[
"/home/cscadmin/aws-mt7"
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Name

MHB-CSC-TraceRouteAndLatencyTest

Content

{

"schemaVersion":"2.2",
"description":"MHB - CSC - TraceRoute and Latency Test",
"mainSteps":[
{

"action":"aws:runShellScript",

"name":"Runscripts",

"inputs":{

"runCommand":[
"/home/cscadmin/aws-mt6"

Name

MHB-CSC-UpdateBypassList

Content

{
"schemaVersion":"2.2",
"description":"MHB - CSC - Update Bypass List",
"mainSteps":[
{
"action":"aws:runShellScript",
"name":"Runscripts",
"inputs":{
"runCommand":[
"/home/cscadmin/aws-bp-refresh-list"
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14.1.3 Run Commands

After you created the Documents, you are ready to Run Commands on the CSC.

You can see the results of the operation on the “Output” section or to store the results on a S3
Buckets for further inspection.

Note: The “Output” Section allows only 2500 characters. The Traceroute and Latency Test uses
more than 2500. We recommend to store this command on a S3 bucket directly.

To Run Commands go to: Systems Manager Services > Run Command

Here an example of Running: MHB-CSC-ShowConfigurationAndStatus

aWS“ Services v  Resource Groups v *
|Commands > Run a command | 1

A command document includes the information about the command you want to run. Select a command document from the following list and then specify parameters for the command

Command document* €}

Owned By Me v ()} Name:MHB Add filter

Name Owner Platform type
2 ®  MHB-CSC-ShowConfigurationAndStatus 544600173127 Linux
MHB-CSC-SpeedTest 544600173127 Linux
MHB-CSC-TraceRouteAndLatencyTest 544690173127 Linux
MHB-CSC-UpdateBypassList 544690173127 Linux

Description MHB - CSC - Show Configuration and Status

Select Targets by* ® Manually Selecting Instances | 3
Specifying a Tag
mi-076d2885f506b1d6d [i ]

Select instances a

Q Filter by attributes
Name Instance ID Instance State Avallability Zon«  Ping Status Last Ping DateT  Agent Version Platform Type Platform Name
4 | @ csc-gre-aws-32 mi-07602885f5. & & oniine May 2,2018at... 2.2.355.0 Linux Ubuntu
cas00101 mi-025e7e0e5. - @ online May 2, 2018 at. 22300 Linux Ubuntu

1. Run a Command

N

Select the Document created

Select the Instances

W

We are selecting only one instance, but you can select as much as you want.

5. Click Run
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Next Screen is:

Commands > Run a command

Run a command

®@ Success
We are running your command against the instances listed below.

Instance IDs  mi-076d2885f506b1d6d

Command ID | 74abceda-5¢36-450b-be11-c91e0e34c416 | Click Command ID

3 (19 »
Click “Command ID
Q Command Id : 74abceda-5c36-450b-be11-c91e0e34cd 16 Add filter
@ cCommandID Instance ID Document name Status Requested date
. 74abceda-5¢36-450b-be11-c91e0e34cd 16 mi-076d2885f506b 1d6d MHB-CSC-ShowConfigurationAndS.. o Success May 2, 2018 at 8:30:27 PM UTC+1

Command ID: 74abceda-5c36-450b-be11-c91ele34c416  Instance ID: mi-076d2885f506b1d6d

Descriptiof Output 1
OQutput
Plugin name Status Response code  Start Time

Finish Time Output S3 bucket S3 key pref

Runscripts @ success 0 May 2, 2018 at £:30:28 PM UTC.. May 2, 2018 at 8:30:30 PM UTC, View Output 27

1. Select “Output”
2. Click “View Output”

and you will be able to see the result of the Run Command:
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Commands > Qutput

Output for Runscripts

GENERAL INFORMATION
Availability Zone: us-east-1d

EC2 Instance id: i-073558Tb385b61521 | Instance Type: t2.small | ami-id: ami-b8acecc5

External Interface (eth®) Subnet-id: subnet-818ceddb | Interface-id: eni-@bc@1b4a20b2bef79 | Security-Group-id:
Internal Interface (ethl) Subnet-id: subnet-8360ecd9 | Interface-id: eni-03f9d912627c65975 | Security-Group-id:

CSC date: Wed May 2 20:30:28 BST 2018
soft version : 2.1

INTERFACES INFORMATION

External Interface (eth®) IP: 172.31.96.125/24 | External Gateway: 172.31.96.1 is Alive
Internal Interface (ethl) IP: 172.31.200.191/24 | Internal Gateway: 172.31.200.1 is Alive

VIP Proxy: 172.31.200.220
Bypass Proxy:172.31.208.112 (--> Bypass Proxy Egress IP 172.31.96.121)

ELASTIC (PUBLIC) IPs INFORMATION
GRE tunnels Public IP: 35.171.35.22
Bypass Proxy Public IP: 35.171.56.120

DNS INFORMATION
Using AWS IP: 169.254.169.253

ZSCALER INFORMATION
Zscaler Cloud: zscalerbeta
GRE tunnels egress Public IP: 35.171.35.22
Primary Tunnel:
ZEN Public IP: 104.129.194.38
Tunnel IPs (local/zen): 172.17.8.113 / 172.17.8.114
Secondary Tunnel:
ZEN Public IP: 199.168.148.131

Only 2500 characters of the output is shown above. If you have logged your output to a S3 bucket, you can view the full output in your S3 bucket

sg-0ffl8e7644d1c6edb
sg-0d63fe7212b9666ce
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